Please read this entire guide. If this guide provides installation or operation instructions, give particular attention to all safety statements included in this guide.
Notices

Trademark Acknowledgments

Please read this entire guide. If this guide provides installation or operation instructions, give particular attention to all safety statements included in this guide.

CableCARD is a trademark of Cable Television Laboratories, Inc.

Other third party trademarks mentioned are the property of their respective owners.

The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1009R)

Publication Disclaimer

Cisco Systems, Inc. assumes no responsibility for errors or omissions that may appear in this publication. We reserve the right to change this publication at any time without notice. This document is not to be construed as conferring by implication, estoppel, or otherwise any license or right under any copyright or patent, whether or not the use of any information in this document employs an invention claimed in any existing or later issued patent.

Copyright

© 2005, 2012 Cisco and/or its affiliates. All rights reserved. Printed in the United States of America.

Information in this publication is subject to change without notice. No part of this publication may be reproduced or transmitted in any form, by photocopy, microfilm, xerography, or any other means, or incorporated into any information retrieval system, electronic or mechanical, for any purpose, without the express permission of Cisco Systems, Inc.
Contents

Chapter 1  Overlay Technology
Overview......................................................................................................................... 1-1
Differences Between a DBDS and an Overlay Environment............................................. 1-2
System Requirements..................................................................................................... 1-6
VOD In an Overlay Environment.................................................................................... 1-7

Chapter 2  Setting Up Digital Source Definitions In an Overlay Environment
Overview......................................................................................................................... 2-1
Add a New Digital Source................................................................................................ 2-2
Build a Partially Encrypted Session................................................................................ 2-3
Encrypt the New Digital Source..................................................................................... 2-7
Verify the Session List...................................................................................................... 2-8

Chapter 3  Managing VOD Sessions In an Overlay Environment
Overview......................................................................................................................... 3-1
Add a Third-Party QAM to the DNCS............................................................................. 3-2
Modify the Third-Party QAM Parameters...................................................................... 3-4
Delete a Third-Party QAM............................................................................................ 3-5

Chapter 4  Releasing Bandwidth on the GoQAM
Overview......................................................................................................................... 4-1
Block a Program to Release Bandwidth on the GoQAM............................................... 4-2

Chapter 5  Customer Information.................................................................................. 5-1

Appendix A  Using DNCS Online Help
Overview......................................................................................................................... A-1
Start DNCS Online Help............................................................................................... A-2
Get Started With DNCS Online Help............................................................................ A-5
Get Help With the Latest System Release..................................................................... A-7
About This Guide

Introduction

This guide describes Cisco’s Overlay technology that supports deployment of Cisco® set-tops in a non-Cisco network environment. With Overlay technology enabled on the Digital Network Control System (DNCS), Cisco set-tops and non-Cisco set-tops can be mixed throughout a common network, independent of headend, hub, or node location. This guide also provides procedures for using Overlay technology on your system, and describes the graphical user interfaces (GUIs) that are applicable in an Overlay environment.

Overlay Technology is an Optional, Licensed Feature

A separate software license from Cisco is required to operate the Overlay technology on your network. For information about obtaining a license to establish an Overlay environment on your system, contact your Cisco marketing representative.

Purpose

After reading this guide you will be able to configure the DNCS to run Overlay technology on your network.

Audience

This guide is written for the following personnel involved in setting up and operating a Digital Broadband Delivery System (DBDS):

- DBDS and DNCS system administrators, engineers, and operators
- Cisco Service engineers
- Call-center personnel

For New Users of Cisco’s DNCS

If you are a new user of Cisco’s DNCS, Appendix A provides instructions for using the DNCS Online Help.

Document version

This is the second release of this guide.
Chapter 1
Overlay Technology

Overview

Introduction
Cisco enhanced its DBDS technology to create a network in which different conditional access (CA) systems can coexist on the same network in a coherent manner. Cisco Overlay technology enables a PowerKEY® DBDS network to be layered on top of an existing, but different, cable network.

Overlay technology is both network architecture and software that provide a level of interoperability between the DBDS and an incumbent network to ensure continued and seamless delivery of digital broadcast and video-on-demand (VOD) services to subscribers.

This chapter provides an overview of the benefits and requirements for using Overlay technology on your system.

In This Chapter

This chapter contains the following topics.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Differences Between a DBDS and an Overlay Environment</td>
<td>1-2</td>
</tr>
<tr>
<td>System Requirements</td>
<td>1-6</td>
</tr>
<tr>
<td>VOD In an Overlay Environment</td>
<td>1-7</td>
</tr>
</tbody>
</table>
Differences Between a DBDS and an Overlay Environment

Overview

You can offer subscribers the services and capabilities provided by a Cisco DBDS by introducing Cisco components into an existing non-Cisco network.

The key innovation that Overlay technology provides to cable service providers is the ability for multiple conditional access (CA) systems to coexist on the same network with only a minimal increase in required plant bandwidth.

To deploy set-tops in a system that utilizes multiple CA and set-top vendors without Overlay technology, the digital content typically must be encrypted by each CA vendor’s equipment and dual-carried on the cable plant. Most cable systems simply cannot support a 100% increase in bandwidth for their encrypted digital services.

Overlay technology partially encrypts the transport stream video to reduce the overhead requirement from 100% to a theoretical minimum of 2%. Instead of 100% of the MPEG content being dual-carried, only “critical packets” from within each MPEG stream are dual-carried and the remainder are left unencrypted and carried once. A “critical packet” is loosely defined as a packet which, once removed from the receiving stream, will prevent reconstruction of the video or audio signal by the receiving device.

Overlay Environment

While a typical Cisco DBDS will support any Cisco set-top, an Overlay environment only supports Cisco set-tops that have versions of the Cisco Resident Application (SARA) written especially for an Overlay environment.

When introducing Cisco set-tops into a non-Cisco network, hardware components must be added to create the digital streams that the Cisco set-tops require. The components that control the set-tops (BFS channel, QPSKs, etc.) are the same in an Overlay environment and a Cisco DBDS. The difference is how the MPEG streams for the digital programs are added into the existing system. These streams are unique to an Overlay environment.
What Additional Hardware is Required in the Overlay Environment?

At the heart of the Cisco Overlay system is the Cisco Gigabit Overlay QAM modulator (GoQAM). The GoQAM provides many new digital broadcast features and innovations for your system and is an integral component of the Overlay environment. The GoQAM allows set-tops from different vendors, running unique conditional access protocols, to operate on the same system while optimizing bandwidth usage. Depending on the system architecture, the GoQAM can be used in either headends or hubs.

Each GoQAM channel accepts two inputs: an unencrypted MPEG transport stream, and the same MPEG transport stream after encryption by a third-party CA vendor. When supplied with these clear and encrypted inputs, the GoQAM will construct the partially encrypted Overlay MPEG stream. Specifically, the GoQAM determines the critical packets, encrypts the clear version of these critical packets using Cisco’s PowerKEY encryption, selects the corresponding critical packets from the third-party encrypted input, selects the remaining clear packets, and multiplexes the selected packets together to create the partially encrypted Overlay transport stream. This stream is then modulated and upconverted to either an IF or RF frequency for output to the HFC plant.

![GoQAM Diagram]

**Note:** Additional hardware may be required to integrate the GoQAM into the overall Overlay environment, as illustrated on the following pages.
Typical Overlay Environment Set Ups

The specific equipment configuration required to provide the clear and encrypted inputs to the GoQAM is highly variable and depends upon the specific hardware configuration of the incumbent CA system onto which Overlay technology will be deployed. Following are two examples that illustrate commonly used connections when Overlay technology is deployed alongside a non-Cisco headend.

Overlay Environment Without a Multiplexor With an IRT

In an Overlay environment without a multiplexor (MUX), the Integrated Receiver Transcoder (IRT) does the encryption for the non-Cisco set-tops.

The following graphic illustrates how Overlay technology interfaces to a non-Cisco headend that uses a simple IRT. The IRT performs a number of functions including Mediacipher encryption. With an IRT, clear and encrypted signals are available through DHEI connectors on the IRT back panel.
Overlay Environment with a MUX

In an Overlay environment with a MUX, the Modular Processing System (MPS) does the encryption for the non-Cisco set-tops. The following graphics illustrate how Overlay technology interfaces to a non-Cisco headend that uses a MUX followed by an MPS. The MPS performs Mediacipher Encryption and may perform QAM modulation, depending upon the specific device.

Example 1:

![Diagram 1](image1)

Example 2:

![Diagram 2](image2)

Note: The MPS is being replaced by the SmartStream Encryptor Modulator (SEM). As with the MPS, a number of different options are available for interfacing Overlay technology with the SEM. Specific details can be obtained by contacting Cisco.
System Requirements

What Software is Required?

The Overlay environment requires that you have the following software versions installed on your system. The documents that describe the features and functionality of the required hardware and software are listed in the Preface of this document.

System Software

• System Release 2.5/3.5, or later
• RF GoQAM 1.1.0 or IF GoQAM 1.1.0, or later

Client Software

Your Overlay network will be installed with the following releases of client code.

• Cisco Resident Application (SARA) 1.54 and PowerTV® OS (OS) 3.10, or later
• DVR 1.3 and Home Server Edition (HSE) 1.6, or later
• 3250HD 1.4.0 and High Definition Edition (HDE) 1.4, or later

Which Cisco Set-Tops Can Be Used in an Overlay Environment?

Currently, you can deploy the following Cisco Explorer® set-tops in an Overlay environment:

• 1850
• 3250, 3250HD
• 8000, 8000HD
• 8300, 8300HD

Important:

• Pace, Panasonic, and Pioneer set-tops are not supported in the Overlay environment.
• In an Overlay environment, you can deploy only CableCARD™ modules developed for the native security system. For example, if you overlay Cisco set-tops into a Motorola system, only Motorola CableCARD modules are supported. You could not deploy a Cisco CableCARD module in a native Motorola system.
• Cisco does not support descrambling analog services in an Overlay environment.
VOD In an Overlay Environment

Overview
The most important aspect of Overlay technology is the manner in which digital broadcast and VOD services are delivered to Cisco set-tops and non-Cisco set-tops.

Delivery of VOD Services
VOD services in an Overlay environment can be delivered either fully encrypted or in the clear (unencrypted).

Clear VOD streams can be delivered by non-Cisco QAMs to Cisco set-tops. Cisco GoQAMs can also deliver clear VOD streams to non-Cisco set-tops.

The DNCS Session and Resource Manager (SRM) handles only Cisco set-tops in an Overlay environment. Although a Cisco set-top might request a VOD service from either a Cisco or a third-party QAM, the DNCS SRM handles the session transactions initiated by the Cisco set-top.

Support for Third-Party QAMS
The DNCS handles exclusive session requests from Cisco set-tops—for streams in the clear—for streams in the clear—served by a non-Cisco QAM (third-party QAM).

If you have the Overlay technology installed on your system and are using QAMs from a vendor other than Cisco, add them to the DNCS. Third-party QAMs are typically used to provide VOD services and for this reason are a part of a service group. See Chapter 3, Managing VOD Sessions In an Overlay Environment, for instructions on adding, modifying, and deleting third-party QAMs.
Chapter 2
Setting Up Digital Source Definitions
In an Overlay Environment

Overview

Introduction

You can add information to the DNCS database about a service or program by setting up a digital source definition. In this case, the source is the content that the DBDS uses to deliver a service to subscribers. When you define the source for a digital service, you also build a session. Sessions define and allocate the resources that the network uses to deliver service content. When building a session, you identify the source equipment where the service content originates, such as an Integrated Receiver Transcoder (IRT). You also identify the distribution equipment that places the service content onto the network, such as a QAM modulator. It may help to think of a session as a pipeline through the DBDS that is allocated to deliver specific service content.

This chapter provides instructions for setting up and encrypting a new digital source in an Overlay environment.

In This Chapter

This chapter contains the following topics.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a New Digital Source</td>
<td>2-2</td>
</tr>
<tr>
<td>Build a Partially Encrypted Session</td>
<td>2-3</td>
</tr>
<tr>
<td>Encrypt the New Digital Source</td>
<td>2-7</td>
</tr>
<tr>
<td>Verify the Session List</td>
<td>2-8</td>
</tr>
</tbody>
</table>
Add a New Digital Source

Quick Path

DNCS Administrative Console > DNCS tab > System Provisioning tab > Source > File > New

Time to Complete

Adding a new digital source takes approximately 5 minutes to complete.

Adding a New Digital Source

To add a new digital source, complete the following steps.

Note: This procedure applies to clear, secure, and PPV services. It does not apply to VOD services.

1. On the DNCS Administrative Console, click the DNCS tab.
2. Click the System Provisioning tab and select Source in the Service Provisioning group.
4. In the Set Up Source window, type the Source Name (maximum 20 alphanumeric characters) to identify this source.

Note: Use a naming scheme that indicates the source type (in this case, digital), the channel number the service will use, and the service name. For example, D106 Golf indicates a digital source (D) providing content on channel 106 for the Golf channel.

5. Type the Source ID (maximum 5 numeric characters). Typically the source ID is 1000 plus the channel number. In this case, the source ID is 1106.

6. Click Save. The system saves the service source information in the DNCS database and closes the Set Up Source window. The Source List window updates to include the new source.

7. Go to Build a Partially Encrypted Session, next in this chapter.
Build a Partially Encrypted Session

Quick Path

DNCS Administrative Console > DNCS tab > System Provisioning tab > Source > [Source Name] > File > Source Definitions > File > New Digital

Time to Complete

Building a partially encrypted session takes approximately 20 minutes to complete.

Before You Begin

Before you create a partially encrypted session, you must have the following information:

• Name and Source ID that you gave the source when you added it to the Source List
• Number of the channel where the service will be displayed
• MPEG program number from your content service provider
• Amount of bandwidth (in Mbps) to allow for the service (from your content service provider)
• Name of the output distribution equipment that will be receiving the service content from the service source (refer to your network map)

Building a Partially Encrypted Session

After adding a digital source to the DNCS, complete the following steps to define parameters for the source and build a session for it.

Notes:

• This procedure assumes the GoQAM and MPEG source has been defined in the DNCS.
• This procedure applies to systems that use the Overlay technology and GoQAMs. If you are sending the same source content through more than one GoQAM, you must define the source for each GoQAM.

1. From the Source List window, highlight the source you want to build a session for, click File, and select Source Definitions.

2. In the Source Definitions List window, click File, and select New Digital.
3. In the Digital Source Set Up window, complete the following fields:
   - Click in the first Session ID field and type 12 zeroes; the system inserts colons for you.
   - Click in the second Session ID field and type the Service Source ID you used when you added the source to the Source List.

**Example:** 00:00:00:00:00:00:1106

4. Digital Sources normally become effective as soon as they are saved. Do you want to delay the effective date and time of this service source?
   - If yes, go to step 5.
   - If no, go to step 9.

**Note:** Subscribers will see a blank channel until either the digital sources are saved or the time you specify arrives.

5. Click **Specify effective date and time** and click **Next**.

6. In the Set Start Time/Date window, click in the Effective Date field and type the month, day, and year you want the content from this source to be available to subscribers.

**Note:** Type two digits for the month and day, and four digits for the year (mmddyyyy). For example: type July 4, 2005, as 07042005.

7. Click in the Effective Time field and type the hour, minute, and second you want subscribers to be able to start viewing content from this source.

**Notes:**
   - Type two digits for each value. For example, type eight o’clock as 080000. The DNCS enters the colons for you and displays 08:00:00.
   - If you prefer, you can represent time in the 24-hour format. For example, you can enter 6:30 p.m. as 183000.

8. Click **AM/PM** to select the portion of the day you want the content from this source available to subscribers.

9. Click **Next**.
10. Because this source will be providing broadcast programming rather than system information, click the **Broadcast programming** option in the Define Session window, and then click **Next**.

11. In the Session Setup window, click the arrow in the Input Device field, select the MPEG source that provides content to the GoQAM, and then click **Next**.

12. In the Output Selection Policy window, click **Select outputs from list** and then click **Next**.

**Important:** Because you have more than one QAM in an Overlay environment, the **Select outputs from list** option ensures that the session is set up on the correct QAM. If you select the **Auto-select outputs (1 per headend)** option, the session may be set up on the wrong QAM; as a result, subscribers will see a black screen.

13. In the Select Outputs window, select the GoQAM Output Transport Stream ID (TSID) that will deliver content to the RF plant, and then click **Next**.
14. In the Wrap-up window, complete the following fields to set up a partially encrypted session for the GoQAM:

- **MPEG Program Number Input**—Type the MPEG program number of the clear input stream that the GoQAM receives.

- **MPEG Program Number Incumbent**—Type the MPEG program number used in the encrypted input stream. The clear and encrypted program numbers may be different, or they may be the same.

- **Bandwidth**—Type the amount of bandwidth (in Mbps) defined by the content provider for this service.

- **Encryption Percentage**—Type 5 in the Audio field and 2 in the Video field. These are the default and recommended percentages. The GoQAM will use Cisco’s encryption method to partially encrypt the video and audio portion of the clear stream.

  **Important:** If you set these percentages too high or too low, you will see a warning message at the bottom of the window suggesting the recommended values. Also, higher percentages require more bandwidth on the GoQAM.

15. Click **Next** and then click **Save**. The system saves the source definition in the database and starts the session you built at the time you specified. The Source Definition window updates to include the new source information.

16. Will other GoQAMs deliver this content to different portions of your network?

  - If **yes**, repeat steps 2 through 15 to build partially encrypted sessions on each GoQAM.
  
  - If **no**, click **File** and select **Close**.

17. Go to **Encrypt the New Digital Source**, next in this chapter.
Encrypt the New Digital Source

Quick Path

DNCS Administrative Console > DNCS tab > System Provisioning tab > Source > [Source Name] > File > Security Modes > File > New

Time to Complete

Encrypting a source takes approximately 10 minutes to complete.

Encrypting the New Source

After adding the new digital source, complete the following steps to securely encrypt the content provided by the new source.

1. From the Source List window, select a source, click File, and select Security Mode. The Security Mode List window opens for the source you selected to encrypt.

2. In the Security Mode List window, click Security Mode.


4. Do you want the content to be encrypted immediately?
   - If yes, in the Date/Time field click Now and then go to step 5.
   - If no, go to step 7.

5. In the Effective Date field, type the month, day, and year you want the content to be encrypted.

6. In the Effective Time field, type the hour, minute, and second you want the content to be encrypted.

7. Click Save.

8. Go to Verify the Session List, next in this chapter.
Verify the Session List

To verify the session list, complete the following steps.

1. From the DNCS Utilities tab, select **Session List**.

2. From the Session Filter window, select a QAM from the list and click **Display Sessions for Selected QAMs**. (You can also use the **Ctrl** or **Shift** keys to select multiple QAMs.) In the Session Data window, the percentage of video and audio encryption that you entered when setting up the digital source definition are shown in these two columns.

3. Scroll until you locate the Session ID you entered. Then, click **Select** on the session row and click **Display Details of Selected Session** to see details of the new session you built.
Chapter 3
Managing VOD Sessions In an Overlay Environment

Overview

Introduction

If you are using QAM modulators from a vendor other than Cisco in your Overlay environment, add them to the DNCS. The non-Cisco QAMs (also referred to as third-party QAMs) are typically used to provide VOD service. For this reason they are part of a service group. If your system uses third-party QAMs and they have not been added to the DNCS, Cisco set-tops may be unable to tune to the correct channel to receive a VOD event.

Before You Begin

Before you begin, you must have your network map available. If you cannot locate your network map, contact Cisco Services. You must also have the following information:

- Number identifying the service group to which each third-party QAM belongs
- Number identifying the transport stream going from each third-party QAM out to the hubs on your system
- Frequency of the channel being used to send data from each third-party QAM to the hubs on your system
- Type of modulation each third-party QAM uses

In this chapter

This chapter contains the following topics.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a Third-Party QAM to the DNCS</td>
<td>3-2</td>
</tr>
<tr>
<td>Modify the Third-Party QAM Parameters</td>
<td>3-4</td>
</tr>
<tr>
<td>Delete a Third-Party QAM</td>
<td>3-5</td>
</tr>
</tbody>
</table>
Add a Third-Party QAM to the DNCS

Overview

By adding the third-party QAMs to the DNCS, you ensure that set-tops receive information about service groups that contain third-party QAMs. If your third-party QAMs are not added to the DNCS, set-tops may be unable to tune to the correct channel to receive a VOD event.

Quick Path

DNCS Administrative Console > DNCS tab > Utilities tab > 3rd Party QAMs > Create

Adding a Third-Party QAM

To add a third-party QAM to the DNCS, complete the following steps.

Note: On the DNCS windows you will see the term 3rd-Party QAM.

1. On the DNCS Administrative Console, click the DNCS tab.
2. On the DNCS tab, click the Utilities tab.
3. On the Utilities tab, click 3rd-Party QAMs. The 3rd-Party Ex. QAM RF Parameters window opens.

Note: The DNCS displays up to 100 third-party QAMs at a time. You can display additional third-party QAMs listed on other pages by clicking Next or Last at the top of the page. You can also search for a specific third-party QAM by clicking Search at the top of the page.
4. Click **Create**. The New data fields appear.

![New data fields](image)

5. For each third-party QAM that you are adding to your system, complete the following fields:
   - **TSID** — Type a unique number to identify the transport stream going from this QAM out to the hubs on your system. You can enter up to 5 digits.
   - **Service Group ID** — Type a unique number to identify the service group to which this QAM belongs.
   - **Frequency** — Type the frequency of the channel you will use to send data from this third-party QAM to the hubs on your system. You can enter a value in 6 MHz increments from 93 to 867.
   - **Modulation Type** — Click the arrow and select the type of modulation this third-party QAM uses. For example, if this were a 256 QAM, you would select **ITU J.83 Annex B (6 MHz)**.

6. Click **Save**. The system saves the information you have entered and updates the 3rd-Party Ex. QAM RF Parameters window with this information.

7. Do you need to add another third-party QAM?
   - If **yes**, repeat steps 4 to 6.
   - If **no**, click **Close**. A message appears asking you to confirm that you want to close the 3rd-Party Ex. QAM RF Parameters window.

8. Click **OK** to close the 3rd-Party Ex. QAM RF Parameters window.
Modify the Third-Party QAM Parameters

Quick Path

DNCS Administrative Console > DNCS tab > Utilities tab > 3rd Party QAMs

Modifying a Third-Party QAM

You can modify any parameters of a third-party QAM whenever needed. To modify a third-party content QAM that is part of your Overlay environment, complete the following steps.

1. On the DNCS Administrative Console, click the DNCS tab.
2. On the DNCS tab, click the Utilities tab.
3. On the Utilities tab, click 3rd-Party QAMs. The 3rd-Party Ex. QAM RF Parameters window opens.

4. Click in the fields that you want to change and type the new information for any of the QAMs listed.
5. Click Update.
6. When you finish making changes, click Save. The DNCS saves the changes.
7. Click Close. A message appears asking you to confirm that you want to close the 3rd-Party Ex. QAM RF Parameters window.
8. Click OK. The 3rd-Party Ex. QAM RF Parameters window closes and saves your changes.
Delete a Third-Party QAM

Quick Path

DNCS Administrative Console > DNCS tab > Utilities tab > 3rd Party QAMs > Delete

Deleting a Third-Party Content QAM

To delete third-party QAMs that are part of your Overlay environment complete the following steps.

1. On the DNCS Administrative Console, click the **DNCS** tab.
2. On the DNCS tab, click the **Utilities** tab.
3. On the Utilities tab, click **3rd-Party QAMs**. The 3rd-Party Ex. QAM RF Parameters window opens.

   ![3rd-Party Ex. QAM RF Parameters Window]

4. Select the QAM that you want to delete and click **Delete**. The third-party QAM is removed from the 3rd-Party Ex. QAM RF Parameters window.

5. Do you need to delete another third-party QAM?
   - If **yes**, repeat steps 3 and 4.
   - If **no**, click **Close**. A message appears asking you to confirm that you want to close the 3rd-Party Ex. QAM RF Parameters window.

6. Click **OK**. The 3rd-Party Ex. QAM RF Parameters window closes.
Chapter 4
Releasing Bandwidth on the GoQAM

Overview

Introduction

Occasionally an IRT or other input device does not correctly drop program bandwidth, and the bandwidth used by that program is still occupied (in use) on the GoQAM. This situation negatively impacts the performance of the GoQAM. In order to block the program and release the occupied bandwidth, you must create a session on the GoQAM with 99 percent encryption for both video and audio.

This chapter provides a procedure for blocking a program to release bandwidth on the GoQAM.

In This Chapter

This chapter contains the following topics.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block a Program to Release Bandwidth on the GoQAM</td>
<td>4-2</td>
</tr>
</tbody>
</table>
Block a Program to Release Bandwidth on the GoQAM

Quick Path:

DNCS Administrative Console > DNCS tab > System Provisioning tab > Source > [Source Name] > File > Source Definitions > File > New Digital

Blocking a Program to Release Bandwidth on the GoQAM

Complete the following steps to block a program to release bandwidth on the GoQAM.

1. On the DNCS Administrative Console, click the DNCS tab.
2. Click the System Provisioning tab and then select Source.
3. Click File and select New.
4. Enter the new source name and ID. For example, type Block HBO in the Source Name field, enter the Source ID of 1106, and then click Save.
5. In the Source List window, click on the row containing the service source you need to define, click File, and then select Source Definitions.
6. In the Source Definition List window, click File, and then select New Digital.
7. In the Digital Source Set Up window, click in the first Session ID field and type 12 zeros; then, click in the second Session ID field and type the Service Source ID you used when you added the source.
8. Click Next.
9. In the Define Session window, click the Broadcast programming option because the source will be providing broadcast (audio/video) programming rather than system information, and then click Next.

Continued on next page
10. In the Session Setup window, click the **Input Device** arrow and select the type of device (the MPEG source) that will be providing the service content (for example, an IRT) and then click **Next**.

**Note:** You defined the MPEG source when you set up your network.

11. In the Output Selection Policy window, select the appropriate output TSID from the list and click **Next**.

12. In the Wrap-up window, complete the following fields:

- **MPEG Program Number Input** — Type the MPEG program number used in the **clear** input stream.

- **MPEG Program Number Incumbent** — Type the MPEG program number used in the **encrypted** input stream.

- **Bandwidth** — Type the amount of bandwidth (in Mbps) that the system should allow for this service. Your content service provider usually defines this value. Requirements vary from system to system.

- **Encryption percentage** — Type 99 for the encryption percentage in both the Audio and Video fields.
Block a Program to Release Bandwidth on the GoQAM, Continued

13. Ignore the warning message that appears and click **Next** again.

14. **Result:** Click **Save**. The system saves the source definition in the DNCS database and starts the session you built for it. The Source Definition List window updates to include the new source information.
If you have technical questions, call Cisco Services for assistance. Follow the menu options to speak with a service engineer.

Access your company's extranet site to view or order additional technical publications. For accessing instructions, contact the representative who handles your account. Check your extranet site often as the information is updated frequently.
Appendix A
Using DNCS Online Help

Overview

Introduction

This appendix includes the following topics that are helpful to new and experienced users of DNCS software:

- **Start DNCS Online Help** — If you are new to the DNCS, start here to learn how to display Online Help.

- **Get Started with DNCS Online Help** — If you are new to the DNCS or have some DNCS experience, see this topic to for a quick review of the information available in Online Help and where this information is located.

- **Get Help With the Latest System Release** — If you are an experienced DNCS operator and want to learn how to use the new features and enhancements provided in the latest system release, start with this topic.

In This Appendix

This appendix contains the following topics.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start DNCS Online Help</td>
<td>A-2</td>
</tr>
<tr>
<td>Get Started With DNCS Online Help</td>
<td>A-5</td>
</tr>
<tr>
<td>Get Help With the Latest System Release</td>
<td>A-7</td>
</tr>
</tbody>
</table>
Start DNCS Online Help

Overview

This section shows different ways to display Online Help, depending on the DNCS window currently displayed. From some windows, you can display Online Help that is specific to the DNCS task you are performing.

From the DNCS Administrative Console

If you are new to the DNCS, the easiest way to display Online Help is from the primary interface that operators use: the DNCS Administrative Console, as shown here. To display *DNCS Online Help*, follow these steps.

1. Click **Help** to display the Help menu.
2. Click **Online Help** to display **DNCS Online Help**.

Result: The Welcome page opens when you use this method.
Start DNCS Online Help, Continued

From List Windows

Many DNCS windows contain a list of items that the DNCS manages. For example, one of these windows lists all of the sources that your DBDS uses. When you are using a window that provides a list of items, you can display Online Help as shown here. To display DNCS Online Help, follow these steps:

1. Click Help to display the Help menu.
2. Click Online Help to display DNCS Online Help.

Result: The Welcome page opens when you use this method.
From Setup Windows

Operators use DNCS windows to set up elements used by their DBDS. For example, from one of these windows, you can set up new sources for a DBDS. When you are using a window to set up an element, display Online Help by clicking the Help button on the window.

**Note:** The Online Help Welcome page displays whenever you use this method.

From Web-based Windows

Some windows on the DNCS display in a Web browser. These windows use hyperlinks (instead of menus) to take you from one window to another.

**Note:** A help page containing information specific to the task you are performing displays when you use this method.

Click Help from the left pane of this window to display information on the CableCARD Data.

**Result:** The CableCARD Data Summary window opens.
Get Started With DNCS Online Help

Overview

This section offers a quick review of the information available in Online Help and how to find what you need quickly.

Help with Common DNCS Tasks

When you display Online Help from the DNCS Administrative Console, a List, or Setup window, the Welcome page appears. The Welcome page contains links to information that is grouped according to tasks that operators commonly perform.

Click any link on the Welcome page to learn more about the topic.

Or

Click any folder under the Contents tab to see related topics. Then click on the topic that interests you.
More Help

The topics in Getting Help provide information about the current and past releases of DNCS Online Help. Getting Help also points you to other sources for assistance.

Help with Tasks for New Users

The topics in Getting Started as a New User help new users become familiar with basic tools on the DNCS Administrative Console and provide tips for getting the most out of DNCS Online Help.

New users can display these topics to learn how to navigate Online Help and become familiar with basic DNCS tools for managing a DBDS.
Get Help With the Latest System Release

Getting Help with the Latest System Release

This section allows experienced DNCS operators to learn how to use features provided in the latest system release and includes links to optional features, such as RCS.

Help With System Release Tasks

The topic What’s New in This Release makes it easy for you to learn about new features and enhancements that the software release supports, including optional features.

An upfront bulleted list gives an at-a-glance summary of new features and enhancements. Click on any link to display details about a feature.
Help with Other Optional Features

If your DBDS uses optional system configurations or features in conjunction with Regional Control System, such as Overlay, there are additional tasks that you will need to perform to manage your DBDS. To find tasks related to various options, click any of the topics that describe optional features, as shown in this example.

Set Up Optional System Configurations briefly describes each optional configuration and provides a link to related procedures.

For assistance with a specific option, click that option to display related procedures.